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Snapple Real Fact #1354 
“You are always looking at 
your nose, your brain just 

chooses to ignore it.” 

Celebrating over 

NINETEEN YEARS 

of Service and  

Satisfied  

Customers! 

We all want to protect our businesses. They’re a 
part of who we are, and it would be devastating if 
anything bad happened — including an unex-
pected cyber-attack. But it happens. Businesses are 
attacked every single day. Some businesses are left 
in ruin. Some can pick up the pieces, but at a great 
cost. Then there are businesses that are back up 
and running in a matter of hours, almost as if noth-
ing happened at all. 

These are businesses that said “yes” to managed IT 
services and made the commitment to protect 
their business, employees and customers. If your 
business lacks managed IT services and you haven’t 
yet embraced total IT security, it’s time to say 
“YES!” and give your business the top-notch IT 
support it needs to protect it from the countless IT 
threats that exist in the world today.  

Managed services essentially offer complete IT 
support without the need to hire dedicated in-
house IT support staff. You get full-time access to 
network and technology experts without having to 
pay a full-time team. In other words, you save 
money and you have someone keeping a close eye 
on your network. The good news is that the IT 
company you already work with may already offer 
managed services — you just have to ask for it!  
(If you don’t work with an IT support company or 
managed services provider (“MSP”), it’s highly 
recommended that you do!)   

Here Are A Few Reasons Why Managed Services 
Should Not Be Ignored: 

It’s A Proactive Service You Can’t Find Anywhere 

(Continued on page 2) 
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“As a business  
owner, you don’t 

have time to 
waste on  

technical and  
operational issues. 

That’s where we shine!  
Call us and put an end to your  

IT problems finally and forever!” 
Fred Holzsager,  

IT Director 

Holzsager Technology Services 

 and  

 Publisher of  

The Tech Insighter 

“We Love Referrals” 2020 Offer 
Keeping with the spirit of helping others,  

if you refer a business to us and they become our customer,  
we will donate $100 to your favorite charity. 

At Holzsager Technology Services, we believe that referrals are the greatest form of flattery.  
By recommending your partners, associates, or professional contacts, you can help them  

enjoy worry-free IT and support a worthy cause of your choice! 

For more information, please see our website at  
www.tech4now.com/we-love-referrals, contact us by phone at 201-797-5050  

or email us at info@tech4now.com . 

“Insider Tips To Make Your Business Run Faster, Easier and More Profitably” 

What Are Managed Services, And Why You Should 
Demand This From Your IT Company 

  GO GREEN: To help save a tree, please send us an e-mail to request electronic  
  delivery. Kindly submit your request to subscribe@tech4now.com 

The Tech Insighter 
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“We make all of your computer 
problems go away without the 

cost of a full-time I.T. staff” 

 
Ask us about our fixed price 

services HTS Insight  
Hassle-Free Agreements—
Computer Support at a flat 

monthly fee you can budget for 
just like rent! 
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“If your dreams don’t scare you, 
they are too small.” 

                            —Richard Branson 

“It is the mark of an educated 
mind to be able to entertain a 
thought without accepting it.” 

                                          —Aristotle 

“There are two ways of spreading 
light: to be the candle or the  
mirror that reflects it..” 

                               —Edith Wharton 

“Happiness is a butterfly, which 
when pursued, is always just  
beyond your grasp, but which, if 
you will sit down quietly, may 
alight upon you.” 

                  —Nathaniel Hawthorne 

“Never trust a computer you can’t 
throw out a window.” 
                               —Steve Wozniak 

“There are no secrets to success.  
It is the result of preparation, hard 
work, and learning from failure.” 
                                   —Colin Powell 

What Are Managed Services... 

Good employee morale is essential to any  
successful business. It’s a reflection of  
company culture and has a direct impact on 
not just happiness but also productivity. Here 
are three surefire ways to improve morale 
within your organization: 

1) Keep The Door Open. When supervisors or 
management vanish without a trace, it hits 
morale hard. It’s crucial to be present and 
available to your team. Sometimes it’s as  
simple as keeping the door open, but it also 
includes having transparent communication. 
Keep people looped in, especially when there 
are good things to report on. On top of that, 
have regular one-on-one chats with everyone 
on the team and make sure their needs are 
being met. 

2) Emphasize Mental Health. Everyone 
should have their mental health acknowl-
edged. Always take time to assess the mental 
health of everyone on your team. If they need 
to take a break or refocus, make sure they do. 
If they need a mental health day (or a vaca-
tion), encourage it. Be flexible and understand-
ing. 

3) Reward And Recognize. Make sure hard 
work gets recognized and people get credit for 
that hard work.  
Shout out star players during meetings and 
make sure everyone (including management) 
sees the good work that’s being done. And 
don’t hesitate to dole out rewards (lunch, gift 
cards, etc.) in recognition of that hard work, as 
well. —Inc., Nov. 4, 2020 

else. Proactive IT support is HUGE. You have to be 
proactive because, guess what? Hackers and cyber-
criminals are proactive. They’re smart people and 
they’re relentless. Managed services will give you 
access to your own outside team of exceptionally 
smart people and systems that can identify IT prob-
lems before they actually become problems.  

On top of that, proactive managed services ensure 
your network – and everything connected to your 
network – receives regular updates, security patch-
es and routine maintenance. Basically, they help 
keep your business protected while minimizing 
downtime that can cut into your bottom line. 

It Helps You Save Money – And You Know How 
Much You’ll Be Spending Month To Month. Hiring 
in-house IT experts is expensive. It’s one of the 
most common reasons why many small- to medium
-sized businesses don’t invest in good IT support. 
The sticker shock is too much. But managed  
services take away the sticker shock.  

Instead, you get the exact support you need, and 
you pay a set fee every month. It makes it MUCH 
easier to set a quarterly or yearly budget. And  
because managed services are customizable, you 
can put together a specific plan for your business 
and pay only for those specifics — there are no fluff 
or padded fees. Managed IT is also scalable, so as 
your business grows or changes, your managed IT 
services can change as well.  

It Protects You In Many Different Ways. You can 
count on your MSP to minimize malware, spyware, 
ransomware, phishing scams and other exploitative 

hacks. You’re protected by advanced software, 
hardware and old-fashioned human knowledge and 
experience. But the protection doesn’t stop there – 
far from it! Managed services providers can also 
protect you against potential natural disasters, such 
as fire or flood, or hardware failures—things that 
are impossible to predict yet possible to prepare 
for.  

They can also protect you when it comes to  
compliance. There are many industries where  
compliance is a big deal, from banking to health 
care. If you operate in one of these industries, you 
know how important this is. Having managed IT 
services means your network is up-to-date with all 
the fine print. You don’t have to worry about any-
thing slipping through the cracks or breaking  
compliance, which can lead to all kinds of costly 
headaches.  

It Gives You TIME. This is the most precious  
commodity of all. If you’re running around dealing 
with network issues yourself – or trying to – you’re 
spending a lot of time doing everything you DIDN’T 
want to be doing when you started your business. 
Wouldn’t you rather be focused on taking care of 
the things you intended to focus on, like growing 
your business and taking care of customers?  

When you bring managed IT into the fold, you have 
so much less to worry about. No, it’s not set-it-and-
forget-it, but it’s close. Your MSP handles your IT, 
while you handle your business—and you collabo-
rate when you need to. You can rest assured that 
someone is keeping a close eye on your network 
and that your MSP is a quick phone call or e-mail 
away (should you have any questions or concerns).  

These few points only scratch the surface of why 
managed services are so important. Stop putting it 
off and make the phone call. Tell your IT company 
you want managed services and you’re ready to 
protect the future of your business! 
Want to get started? Give us a call or an email. 

(Continued from page 1)  

 If you would like to have us 
speak to your organization and 
give away some free copies to  
attendees, give us a call. For 

more details on the contents and 
how to get your own copy, please 

visit our special web page at 
www.tech4now.com/cybercrime 

Three Simple Yet Effective Ways to Boost Employee Morale 

Read Fred’s Book! 

“Having managed IT 
services means your 
network is up-to-date with 
all the fine print.” 
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How many times have you wanted to 
send a simple email to multiple people, 
but on a one-off basis? 

Email Templates 

To create an email template is relatively simple 
and straightforward.  To do so, just follow these 
instructions: 

1.Draft the message that you want to use.  
Click on New email.  This means providing a 
Subject Line, Message Body and any attach-
ments that you wish to use in the Outlook 
email.  IMPORTANT:  Before you save the 
template, make sure Options > Save Sent 
Item To goes to your Sent Items Folder.  
Otherwise, future e-mails sent will not always 
go there automatically.  Be sure to check! 

2. Click on File > Save As.  You will be 
prompted to select a location and a file name.  
Remember to change the default from Outlook 
Message Format—Unicode (*.msg) to Outlook 
Template (*.oft). 

3. When you are ready to use the Template to 
send your repeated message, simply click on 
the template and you will have a “fresh” copy 
of what you wanted to send readily available. 

Did you know you could do a similar 
process using Microsoft Word? 

Word Document Templates 

To create a Word Document Template, you 
may use either an existing document that you 
wish to model or make a new one from scratch. 

1. For a NEW document, create your document, 
when you are ready to save it, Click on File > 
Save As.   

2.For your location, Select This PC > My  
Documents > Custom Office Templates. 
(Yes, you read it right.  Templates may be used 
with other Office Applications, too!) 

3. Name the file as desired. 

4.Choose Save as type: Word Template 
(*.dotx).  (see Fig. 1) [Note: the *.dotx is to 
help you find it as a Document Template.] 

5. If you wish to convert an existing file into a 
template, just Click File > Save As, then 
change the file type to Word Template, Word 
should automatically change the target folder 
to the same location as shown in item #2. 

6. Whenever you make changes to the global 
template for Word, it affects the Normal.dotm 
file.  This file is found at C:\Users\<username> 
\AppData\Roaming\Microsoft\Templates.   
 

If you edit this file, you may cause issues to 
your version of Word.  [If Word finds a bad 
normal.dotm, it will create a new generic 
copy.]  Before you edit it, we suggest you open 
help and enter Change the Normal Template 
(Normal.dotm).   Make any changes you want 
to the fonts, margins, spacing, and other set-
tings. You can use the same commands and 
features you use to change a document — but 
remember, any changes you make to the  
Normal.dotm will be applied to documents 
you create in the future.  Don’t forget to hit 
Save after adding changes. 

7. When you need to use the template, simply 
open Word, click on New and you may select 
the template from the “Personal” selection. 

Quick Tech Productivity Pointers 

Find Out  
with a Complimentary  

Dark Web Scan 

Did you know…? 

• Cyber-attacks have continued 
to grow in cost, size, and  
impact—causing 60% of SMBs to 
go out of business within 6 
months of a cyber incident.   

• Over 80% of data breaches  
leverage stolen passwords as the 
principal attack vector—often  
acquired on the Dark Web. 

•Far too often, companies that 
have had their credentials  
compromised and sold on the 
Dark Web don’t know it until they 
have been informed by law en-
forcement—but then, it’s too late. 

•  To help keep your critical  
business assets safe from the 
compromises that lead to breach 
and theft, we are offering a  
complimentary, one-time scan 
with Dark Web ID™ Credential 
Monitoring. 

If you are interested in learning 
more about the risks involved in 
ignoring your password security, 
give us a call at (201) 797-5050  

or visit our website at 

https://www.tech4now.com/dwid 
or www.tech4now.com/bullphish 

Fig. 1: When creating a Template, remember to choose *.dotx. 



 

2021©Holzsager Technology Services, LLC www.tech4now.com (201) 797-5050 

Services We Offer: 

✓ Hassle-Free IT powered by HTS Insight Managed Services 
✓ General Network Repair and Troubleshooting 
✓ Onsite and Offsite Backup 
✓ Disaster Recovery and Business Continuity Planning 
✓ Virus Protection & Removal and Dark Web Monitoring 
✓ Network Security and Online Employee Security Training 
✓ Mobile and Hosted “Cloud” Computing 
✓ E-mail & Internet Solutions 
✓ Wireless Networking 
✓ Spam Filtering and E-mail Archiving Solutions 
✓ Storage Solutions and File Sharing 
✓ System Audits, Network Documentation, and Dark Web Scans 
✓ Voice over IP phone systems 
 

“We make all of your computer problems go away without the 
cost of a full-time I.T. staff” 
Ask us about our fixed price service agreements—Computer support at a 
flat monthly fee you can budget for just like rent! 

The Engineer’s choice 
Two engineering students were riding their 
bicycles across a university campus when 
one said, "Where did you get the great 
bike?"  
The second engineer replied, "Well, I was 
walking yesterday, minding my own business, 
when a beautiful woman rode up on this bike, 
threw it to the ground, took off all her 
clothes and said, "Take what you want."  
The first engineer nodded approvingly and 
said, "Good choice: The clothes probably 
wouldn't have fit you anyway."   
The Engineer’s opinion 
To the optimist, the glass is half-full.  
To the pessimist, the glass is half-empty.  
To the engineer, the glass is twice as big as 
it needs to be.  
It could always be worse  
There I was, sitting by myself at the bar 
staring at my untouched drink.  Suddenly, a 
6' 8" tattooed goon steps up next to me and 
grabs my drink.  He then grins at me and 
gulps down my drink in one swig  " Whatcha 
gonna do about it?" he says, menacingly, as I 
burst into tears. 
"This is the worst day of my life," I say to 
him.  "I'm a complete failure.  I was late to 
a meeting and my boss fired me.  When I 
went to the parking lot, I found my car had 
been stolen and I don't have any insurance.  
I left my wallet in the cab I took home.  I 

found my old lady in bed with the gardener, 
and then my dog bit me." 
"So, I came to this bar to work up the cour-
age to put an end to it all.  I buy a drink, I 
drop a capsule in and sit here watching the 
poison dissolve.  Then you show up and drink 
the whole thing!”  —  “But enough about me.  
How's your day going? 
New York State of Mind  
Do you know why New Yorkers are always so 
depressed?  
Because the light at the end of the tunnel is 
New Jersey. 
New York City Dirty Water Dog 
The Zen Master is visiting New York City 
from Tibet.  He goes up to a hot-dog vendor 
and says, "Make me one with everything." 
The hot dog vendor fixes a hot dog and 
hands it to the Zen Master, who pays with a 
$20 bill.  The vendor puts the bill in the 
cash box and closes it.  "My change?" asks 
the Zen Master.  The vendor responds, 
"Change must come from within." 
Twain and the Mormon 
A Mormon acquaintance once pushed Mark 
Twain into an argument on the issue of  
polygamy. After long and tedious exposi-
tions justifying the practice, the Mormon 
demanded that Twain cite any passage of 
scripture expressly forbidding polygamy. 
"Nothing easier," Twain replied. "No man 
can serve two masters." 

The Lighter Side... 

IT Solutions for  
YOUR Business! 

Phone: (201)797-5050 
E-mail: support@tech4now.com 

Holzsager Technology Services, LLC 
P.O. Box 535 

Fair Lawn, NJ  07410-0535 

“I cannot say enough great things about Fred and Holzsager Technologies. He is knowledge-able, 

responsive, patient and prompt. Not only do they handle my IT issues, they also do my daily back-

ups, monitoring and just built me a new computer.  If you’ve tried all the rest, now try the best.” 

—Mitch Cohen, PuroClean Emergency Restoration Specialists, Fair Lawn, NJ & Nanuet, NY 

Holzsager Technology Services, LLC 
P.O. Box 535 

Fair Lawn, NJ  07410-0535 
(201) 797-5050 

info@tech4now.com 
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Celebrating over 

NINETEEN YEARS 

of Service and  

Satisfied  

Customers! 

Feedback & Suggestions… 
 

Is there a topic or feature you 
would like to include in a future 
issue?  Opinions and feedback are 
welcome and encouraged. Please 
send us an e-mail or call our direct 
line. 
 

E-mail: info@tech4now.com 
Phone: (201) 797-5050 

5 Reasons To Choose A 
Hosted VoIP Phone System 

 

1. COST SAVINGS  
2. ANSWER CALLS ANYWHERE  
3. ON-DEMAND SCALABILITY  
4. WORLD-CLASS FEATURES  
5. ENHANCED PRODUCTIVITY  
 
As a small business, you need every 
advantage to be as efficient and 
productive as possible. Holzsager 
Technology Services is proud to 
provide our clients with a cost-
effective, feature-rich, world-class 
phone system that is easy to use 
and sure to enhance your business 
productivity.  

For more information order our: 
 

   FREE REPORT 
"The Ultimate Guide to Choosing 
the RIGHT VoIP Phone System" 

 

 

 

 

 

 

 
Contact us at  

(201) 797-5050 or 
www.tech4now.com/services/voip-phones 

For Entertainment Purposes ONLY! 


